Contents

Introduction ................................................................. 4
Loading Paper ............................................................. 5
Using Special Papers ....................................................... 7

Copying a Document or Photo ........................................... 9
Placing the Original on the Glass ....................................... 9
Copying a Document ....................................................... 10
Copying a Photo .......................................................... 11
Restoring and Cropping Photos ......................................... 12
Copy and Restore Print Settings ......................................... 13

Printing From a Memory Card ........................................... 14
Compatible Cards and Image Formats .................................. 14
Inserting the Card ........................................................ 15
Selecting Individual Photos for Printing ............................... 16
Selecting All Photos for Printing ....................................... 17
Printing Photos From an Index Sheet ................................. 18
Memory Card Print Settings ............................................. 20

Printing From Your Computer .......................................... 21
Printing in Windows ....................................................... 21
Printing With a Macintosh ............................................... 23
Selecting the Correct Paper Type ...................................... 27

Scanning a Document or Photo ........................................ 28
Basic Scanning ............................................................ 28
Restoring and Correcting Photos ....................................... 29
### Maintaining Your All-in-One
- Checking the Print Head Nozzles ........................................... 30
- Cleaning the Print Head .................................................. 31
- Checking Ink Levels ....................................................... 32
- Purchasing Epson Ink Cartridges ......................................... 32
- Replacing Ink Cartridges .................................................. 33

### Solving Problems
- Checking for Software Updates ........................................... 36
- Error Indicators ............................................................... 37
- Problems and Solutions ..................................................... 38
- Where To Get Help .......................................................... 40

### Notices................................................................. 41
Introduction

After you have set up your Epson Stylus® NX400 Series all-in-one as described on the Start Here sheet, turn here to:

■ Load paper
■ Make a copy of a document or photo
■ Print from a memory card or digital camera
■ Get the basic steps for printing from your computer
■ Scan a document or photo and restore or correct the color
■ Perform routine maintenance
■ Solve simple problems

This book tells you how to do most of these things without ever turning on your computer! Of course, your NX400 Series can do a lot more when you connect it to your Windows® or Macintosh® computer. For additional instructions, see the on-screen User's Guide by double-clicking its icon on your desktop.

Please follow these guidelines as you read your NX400 Series instructions:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your NX400 Series.

Tip:
Tips contain hints for better copying, scanning, and printing.
Loading Paper

You can print documents and photos on a variety of paper types and sizes. For details, see page 7.

1. Open the paper support and pull up the extensions. Then open the output tray, pull out the extensions, and raise the stopper.

2. Squeeze the edge guide and slide it left.

Tip: If the feeder guard is in the way, flip it forward.
3. Insert the paper, glossy or printable side up, against the right side and beneath the tab. (Load letterhead or pre-printed paper top edge first.)

You can load up to 120 sheets of plain paper, 80 sheets of matte, or 20 sheets of photo paper. Load other special papers one sheet at a time.

Note:
The type of paper you choose affects the way your printout looks. If you are just making a copy or printing a rough draft, plain paper is fine. However, for the best results, you’ll want to use one of Epson’s special ink jet papers designed for your printer. For example, your photos will look great printed on Epson Premium Photo Paper Glossy (see page 7 for more information).

4. Slide the edge guide against the paper, but not too tightly.

Note:
For instructions on loading envelopes, see your on-screen User’s Guide.
Using Special Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies CentralSM at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041934, S042181, S042174</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041935, S042182, S042175</td>
<td>20</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041808, S041727</td>
<td>40, 100</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041286, S042183, S041667</td>
<td>20</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Borderless 4 × 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Borderless 4 × 6 inches</td>
<td>S041809, S042038</td>
<td>50, 100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141, S041649, S041271</td>
<td>20, 50, 100</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Borderless 8 × 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041257, S042180</td>
<td>50, 100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Paper type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Copying a Document or Photo

Follow the instructions in this section to position your originals correctly on the glass and make color or black and white copies.

Placing the Original on the Glass

1. Open the document cover and place your original face-down on the glass, with the top facing into the front right corner.

   Move the photo or document slightly away from the edges.

2. Close the cover gently so you don’t move the original.
**Copying a Document**

You can copy documents onto letter- or A4-size plain paper or Epson special paper just like you would on a copy machine.

1. Press the **On** button to turn on the NX400 Series.
2. Load letter- or A4-size plain paper or Epson special paper in the sheet feeder (see page 5).
3. Place your original document on the document table (see page 9).
4. Press the **Copy** button to enter copy mode.
5. Flip up the LCD display screen.
6. To print more than 1 copy, press + or – to select the number (up to 99).
7. Press ◄ or ► to select Color or B&W copies.
8. Press ▼, then press ► to change the layout.
   Select With Border to leave a small margin around the image or select Borderless to expand the image all the way to the edge of the paper (slight cropping may occur).
   
   **Note:**
   You cannot print borderless on plain paper.

9. To change any other print settings, press **Menu** and select your settings (see page 13 for details). When you’re done, press **OK**.
10. Press ◙ **Start** to begin copying.

   If you need to cancel copying, press ◙ **Stop/Clear Settings**.
Copying a Photo

You can copy photos onto 4 × 6-inch, 5 × 7-inch, letter-size, or A4-size Epson® photo paper (various types available) for instant photo reprints. You can also print with or without borders and convert color photos to black and white.

1. Press the On button to turn on the NX400 Series.
2. Load 4 × 6-inch, 5 × 7-inch, letter-size, or A4-size Epson photo paper in the sheet feeder (see page 5).
3. Place your original photo on the document table (see page 9).

   **Note:**
   You can copy up to 2 photos at the same time. Place them 0.2 inches (5 mm) apart.

4. Press the Copy button.
5. Flip up the LCD display screen.
6. To print more than 1 copy, press + or – to select the number (up to 99).
7. Press ◀ or ▶ to select Color or B&W copies.
8. Press ▼, then press ▶ to change the layout.

   Select With Border to leave a small margin around the image or select Borderless to expand the image all the way to the edge of the paper (slight cropping may occur).

   **Note:**
   You cannot print borderless on plain paper.
9. To change any other print settings, press Menu and select your settings (see page 13 for details). When you’re done, press OK.
10. Press ◇ Start to begin copying.

    If you need to cancel copying, press ◇ Stop/Clear Settings.
Restoring and Cropping Photos

You can restore old, faded photos to their original brilliance. You can also crop your photos to zoom in on the subject.

**Note:**
To restore photos larger than 5 × 7 inches, use the NX400 Series software on your computer.

1. Press the ☺ On button to turn on the NX400 Series.
2. Load 4 × 6-inch, 5 × 7-inch, letter-size, or A4-size Epson photo paper.
3. Place your original photo on the document table.

**Note:**
You can copy up to 2 photos at the same time. Place them 0.2 inches (5 mm) apart.

4. Press the Photo button, and press OK.
5. To turn on Color Restoration, press ▶ and select On and press OK. (If your photo is not faded, do not turn on Color Restoration.)
6. Press OK again to prescan your photo. You see these settings over a preview of your photo:
7. To print more than 1 copy, press + or – to select the number.
8. If you want to crop your photos and enlarge the resulting image area to fit onto your paper, press Display/Crop.
   - To resize the image area, press + or –.
   - To move the image area, use the arrow buttons.
   - To check the zoomed image, press OK.
   After you are done cropping your photo, press OK.
9. To change print settings, press Menu and select your settings (see page 13). When you're done, press OK.
10. Press ◊ Start to begin copying. If you need to cancel copying, press ◊ Stop/ Clear Settings.
Copy and Restore Print Settings

Press the Menu button to change settings. When you’re done, press OK.

- To adjust the copy size, select Zoom (reduction/enlargement) and choose Actual (to select a percentage using + or –) or Auto Fit Page (to automatically size the image to fit your paper).

- To change the paper type, select Paper Type and choose the type of paper you loaded.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper</td>
</tr>
</tbody>
</table>

- To change the paper size, select Paper Size and choose the size you loaded.

  **Note:**
  Paper Size options depend on the Paper Type you choose.

- To change the print quality, select Quality and choose Draft, Standard, or Best.

  **Note:**
  For photos, the default setting for Quality is Standard.

- To adjust the darkness or lightness of the print, select Density and choose a higher (darker) or lower (lighter) setting.

- To adjust the amount of image expansion when printing borderless photos, select Expansion and choose Standard, Min, or Mid.

  **Note:**
  You may see white borders on your printed photo if you use the Min setting.
Printing From a Memory Card

The NX400 Series all-in-one lets you print photos directly from your digital camera’s memory card; just insert it into one of the memory card slots and you’re ready to print.

See the User’s Guide for instructions on copying memory card files between your NX400 Series and a computer; printing photos directly from your camera; printing photos pre-selected in your camera (DPOF™ or Digital Print Order Format); printing photos by date; and printing photos from a slideshow.

Compatible Cards and Image Formats

You can use the following types of cards with your NX400 Series:

<table>
<thead>
<tr>
<th>Slot</th>
<th>Type of card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left slot</td>
<td>SD™, SDHC™, miniSD™<em>, miniSDHC</em>, microSD*, microSDHC*, MultiMediaCard™, Memory Stick™, Memory Stick Duo™<em>, Memory Stick PRO™, Memory Stick PRO Duo™</em>, Memory Stick Micro™, MagicGate™ Memory Stick, MagicGate Memory Stick Duo™*, xD-Picture Card™, xD-Picture Card Type H, xD-Picture Card Type M</td>
</tr>
<tr>
<td>Right slot</td>
<td>CompactFlash® Type I and II, Microdrive™</td>
</tr>
</tbody>
</table>

* Adapter required
The NX400 Series supports image files that meet the following requirements:

<table>
<thead>
<tr>
<th>Media format</th>
<th>DCF version 1.0 or 2.0 compliant*</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>JPEG</td>
</tr>
<tr>
<td></td>
<td>Supports Exif version 2.21</td>
</tr>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 9200 × 9200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 999</td>
</tr>
</tbody>
</table>

* DCF is the “Design rule for Camera File system” standard

**Note:**
You can print only in color when printing directly from a memory card; you cannot print in black and white.

---

**Inserting the Card**

1. Make sure the NX400 Series is turned on.
2. Insert your card into the correct slot as shown:

   Insert just one card at a time (it won’t go in all the way)

The memory card access light flashes and stays lit. Now you can:

- View your photos on the LCD display screen and print them (page 16)
- Print an index sheet so you can select which photos to print (see page 18)
When you want to remove the card, make sure the memory card access light is not flashing, then pull the card straight out of its slot.

**Caution:**
Do not remove the card or turn off the NX400 Series while the memory card access light is flashing; you may lose data on the card.

---

**Selecting Individual Photos for Printing**

You can select individual photos for printing as you view them on the LCD display screen.

1. Press the Memory Card button. You see this screen:

2. Press OK to select View and Print Photos.

3. Press ◀ or ▶ to move through your photos and display one that you want to print.

4. Press the + or – button to select the number of copies you want of that photo.

5. If you want to crop your photo and enlarge the resulting image area to fit onto your paper, press Display/Crop.
   - To resize the image area, press + or –.
   - To move the image area, use the arrow buttons.
   - To check the zoomed image, press OK.
   - To rotate the image area, press Menu.

   After you finish cropping your photo, press OK.

6. Repeat steps 3 through 5 to select more photos, if you want.

7. To change any of the print settings displayed on the screen, press Menu and select your settings (see page 20). When you're done, press OK.


**Note:**
You can change the way your photos appear on the LCD display screen. Press Setup, select Maintenance, select Display Format, then select 1-up With Info, 1-up without Info, or View Thumbnail Images.
Selecting All Photos for Printing

You can quickly select all of the photos on your memory card for printing.

1. Press ◄ or ► to select Print All Photos, then press OK.

2. To print one copy of all the photos on 4 × 6-inch Epson photo paper (various types available), press ◇ Start and go to step 5.
   To select multiple copies with different print settings, press OK and continue with step 3.

3. To print more than 1 copy, press + or – to select the number.

4. To change any of the other print settings, press Menu (see page 20). When you’re done, press OK.

5. When you’re ready to print, press ◇ Start.
   If you need to cancel printing, press ◇ Stop/Clear Settings.
Printing Photos From an Index Sheet

You can print an index sheet containing small versions of all the photos on your memory card. Then you can select the photos you want by marking them on the sheet and scanning the sheet. The NX400 Series automatically prints them.

**Printing an Index Sheet**

1. Load several sheets of plain letter- or A4-size paper (see page 5).
2. Insert a memory card in a memory card slot (see page 15).
3. Press the Memory Card button to enter memory card mode.
4. Press \ or ▲ to select Print Index Sheet.
5. Press OK, then select the index sheet options you want and press OK again.
   - To select the photos to include in the index sheet, choose Select, then select All Photos, Latest 30, Latest 60, or Latest 90 (beginning with the last photo by file name).
   - To print the date or file name of each photo on the index sheet, select Information and choose Date or File Name.
6. Press ◀ Start to print the index sheet. The most recent photos are printed on the first index sheet. If you need to cancel printing, press ◀ Stop/Clear Settings.

Now you can select the photos you want to print (see the next section).
Printing Photos From The Index Sheet

Once you have printed an index sheet (see page 18), you can mark the photos you want to print right on the sheet, scan the sheet, and print the photos automatically.

1. Use a dark pen or pencil to fill in the circles on the sheet.

- Select the paper type and size you want to use.
- Select Borderless or With Border layout.
- If you want to print the date the photo was taken on each photo, fill in the Print date on photos circle.
- Fill in one circle beneath each photo you want to print. The numbers indicate how many copies you want of that photo. If you want to print one copy of all the photos on the index sheet, fill in the All circle at the top.

2. Open the document cover. Then place the index sheet face-down on the glass, in the lower right corner so that the top of the sheet is aligned against the right edge of the glass. Close the document cover.
3. Load the type of paper on which you want to print your photos, either plain or photo paper.

4. Make sure your memory card is still inserted and the LCD display screen shows Print Photos from Index Sheet highlighted.

5. Press OK, then press Start to start scanning and printing. Wait until printing finishes before printing from any additional index sheets. If you need to cancel printing, press Stop/Clear Settings.

---

**Memory Card Print Settings**

Press the Menu button to change settings. When you’re done, press OK.

- To change the paper type, select Paper Type and choose the type of paper you loaded (see page 13).

- To change the paper size, select Paper Size and choose the size of paper you loaded.

  **Note:**
  Paper Size options depend on the Paper Type you choose.

- To change the layout, select Layout and choose With Border to leave a small margin around the image or select Borderless to expand the image all the way to the edge of the paper (slight cropping may occur).

- To change the print quality, select Quality and choose Standard, Best, or Draft.

  **Note:**
  For photos, the default setting for Quality is Standard. You can change this setting only when you print on plain paper.

- To print the date on your photos and select the format for it, select Date and choose the format you want.

- To improve print quality, select Bidirectional and choose Off (choose On for faster print speed).

- To adjust the amount of image expansion when printing borderless photos, select Expansion and choose Standard, Min., or Mid.

  **Note:**
  You may see white borders on your printed photo if you use the Min setting.
Printing From Your Computer

This section describes the basic steps for printing a photo or document stored on your Windows or Macintosh computer. For detailed instructions on printing, see the on-screen User’s Guide.

Before you start, make sure you’ve installed your printer software and connected the NX400 Series to your computer as described on the Start Here sheet.

Tip:
It’s a good idea to check for updates to your NX400 Series software (see page 36 for instructions).

Printing in Windows

1. Load paper (see page 5).
2. Open a photo or document in a Windows program.
3. Open the File menu and select Print. You see a window like this one:

![Print window](image)

4. Make sure EPSON Stylus NX400 Series is selected, then click the Preferences or Properties button.
5. On the Main tab, select the basic print settings. Make sure you choose the correct paper Type setting for the paper you are using (see page 27 for details).

Note:
For quick access to the most common settings, click the Shortcuts tab and select one of the presets. You can create your own presets by clicking the Save Settings button on the Advanced tab.

6. If you want to reduce or enlarge your printout, or print double-sided, click the Page Layout tab and select settings as necessary.

7. For more printing options, click the Advanced tab.

Note:
For more information about print settings, click Help or see your on-screen User’s Guide.

8. Click OK to save your settings.
9. Click OK or Print to start printing. This window appears and shows the progress of your print job.

![Printer settings window]

**Printing With a Macintosh**

See the section below for your Mac OS® operating system.

**Mac OS X 10.5**

1. Open a photo or document in an application.
2. Open the File menu and select Print.
3. Select EPSON Stylus NX400 Series as the Printer setting.
4. Click the arrow to expand the Print window, if necessary.
5. Select the basic copy and page settings. For borderless photos, choose a Paper Size setting with a Sheet Feeder - Borderless option.

**Note:**
If the setting you want isn’t shown (for example, Scale), check for it in your application before printing. Or check for it in the settings for your application at the bottom of this window.

6. Choose **Print Settings** from the pop-up menu, and select the following print settings:
7. Choose any other printing options you may need from the pop-up menu. See the on-screen User’s Guide for details.

8. Click Print.

9. To monitor your print job, click the printer icon in the dock.

**Mac OS X 10.3 to 10.4**

1. Open a photo or document in an application.

2. Open the File menu and select *Page Setup*. Select the following settings:

   - **Select Stylus NX400**
   - **Select your Paper Size**
   - **Select your document or image orientation**

   For borderless printing, choose a **Sheet Feeder - Borderless** option in the Paper Size list for your paper size (US Letter, 8 x 10 in, 5 x 7 in, or 4 x 6 in).

3. Click OK to close the Page Setup window.
4. Select Print from the File menu. Select Stylus NX400, choose Print Settings from the pop-up menu, and select the following settings as necessary:

Note: In certain programs, you may need to select Advanced before you can select Print Settings. For more information about printer settings, click the ? button.

5. Choose any other printing options you may need from the pop-up menu. See your on-screen User's Guide for details.

6. Click the Advanced button to change additional settings.

Note: For more information on advanced settings click ?.

7. Click Print.
8. To monitor the progress of your print job, click the printer icon in the dock (or click the Print Center icon and double-click Stylus NX400 on the next screen).

Selecting the Correct Paper Type

Select the correct Type (see page 22) or Media Type (see page 26) setting in your printer software. This tells the NX400 Series what kind of paper you’re using, so the ink coverage can be adjusted accordingly.

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>
Scanning a Document or Photo

You can use your Epson Stylus NX400 Series all-in-one to scan a photo or document and save it on your computer or other device.

You can even restore and correct photographs as you scan (see page 29).

The Epson Scan software provides three scanning modes:
- **Full Auto Mode** scans quickly and easily using automatic settings.
- **Home Mode** previews your image and provides preset options for scanning.
- **Professional Mode** previews your image and provides a full array of tools.

**Note:**
For detailed scanning instructions, see the on-screen *User’s Guide*.

Basic Scanning

You can scan from any TWAIN-compliant application—such as ArcSoft Print Creations™—using Epson Scan. Or you can start Epson Scan directly from your computer and save your image to a file.

1. Open the document cover and place your original face-down on the glass, in the front right corner, as shown on page 9.
2. Close the cover gently so you don’t move the original.
3. Do one of the following to start Epson Scan:
   - **Windows:**
     Double-click the **EPSON Scan** icon on your desktop.
   - **Macintosh:**
     Double-click **EPSON Scan** in the Applications folder.
   - If you are scanning from an application, start your application. Then open the File menu, choose **Import** or **Acquire**, and select **EPSON NX400**.
You see the Epson Scan standby window:

4. If the Mode setting in the upper right corner is set to Full Auto Mode, click the Scan button.

If you are in Home or Professional Mode, you see a different Epson Scan settings window. (You can change the mode using the Mode selector in the upper right corner.)

5. If you want to restore faded color in a photo or make other corrections, click Customize. Then follow the instructions below.

6. Click OK. The image is scanned and you see its icon in Windows Explorer or Macintosh Finder.

---

Restoring and Correcting Photos

You can automatically transform a faded, dusty, or badly exposed color photo into one with true-to-life color and sharpness as you scan. Use the Color Restoration and Dust Removal options in Epson Scan's Full Auto Mode. In Home and Professional Mode, you can also select Backlight Correction to remove shadows from images with too much background light.

**Full Auto Mode**

Click the Customize button, click Dust Removal and/or Color Restoration, click OK, and click Scan.

**Note:**

For more information, see the on-screen User's Guide. You can also click Help on the Epson Scan screen for information about all the available settings.
Maintaining Your All-in-One

Follow the instructions in this chapter for checking and cleaning the print head nozzles and replacing ink cartridges. To align the print head, if necessary, see your on-screen User's Guide.

Caution:
To keep your NX400 Series looking like new, don’t place anything on top of the cover or use it as a writing surface. If you need to clean the cover, use only a soft, non-abrasive microfiber-type cloth.

Checking the Print Head Nozzles

If your printouts are faint or have gaps in them, some of the nozzles in the print head may be clogged or ink may be running low in one or more of the ink cartridges. Follow the steps below to check the print head nozzles.

1. Load letter-size paper in the sheet feeder (see page 5).
2. Press Setup.
3. Press ◀ or ► to select Maintenance, then press OK.
4. Select Nozzle Check and press OK.
5. Press ◇ Start.
6. Check the nozzle check pattern that prints to see if there are gaps in the lines.

   ![Nozzle Check Pattern]

   Nozzles are clean  Nozzles need cleaning

7. If there are no gaps, press OK.
   If there are gaps or the pattern is faint, press ◇ Start to clean the print head (see page 31).
Cleaning the Print Head

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head. Print head cleaning uses ink, so clean it only if necessary.

**Note:**
You cannot clean the print head if an ink cartridge is expended or low. You must replace the cartridge first (see page 33).

1. Load letter-size paper in the sheet feeder (see page 5).
2. Press **Setup**.
3. Press ‹ or › to select **Maintenance** and press **OK**.
4. Press ▼ to select **Head Cleaning** and press **OK**.
5. Press ◀ Start.

   Cleaning takes approximately one minute. When it’s finished, you see a message on the display screen.

   **Caution:**
   Never turn off the NX400 Series during head cleaning or you may damage it.

6. Press ◀ Start to run a nozzle check (as described on page 30) to verify that the print head is clean.

7. If there are still gaps or lines, or the test patterns are faint, run another cleaning cycle and check the nozzles again.

**Note:**
If you don’t see any improvement after cleaning the print head four times, turn off your NX400 Series and wait at least six hours to let any dried ink soften. Then try cleaning the print head again. If quality does not improve, one of the ink cartridges may need to be replaced. If that doesn’t help, contact Epson as described on page 40.

If you do not use your NX400 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.
Checking Ink Levels

You can check ink levels any time using the LCD display screen.

**Note:**
You cannot print or copy when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing or copying.

1. Press **Setup**.
2. Press ▼ or ► to select **Ink Levels** and press **OK**.
   
   A cartridge marked with an ! is getting low on ink. See page 33 to replace the cartridge.
3. Press **Back** as necessary to return to the main screen.

A window may also appear on your computer screen when you try to print when ink is low. This window can optionally display ink offers and other updates retrieved from an Epson website. On a Windows computer that is connected to the Internet, you may see a screen asking if you want to receive these Epson offers the first time you try to print when ink is low. Click **Accept** or **Decline**.

**Note:**
To disable checking for ink offers or updates from Epson, see the instructions in your on-screen **User’s Guide**.

Purchasing Epson Ink Cartridges

You can purchase genuine Epson ink and paper from Epson Supplies Central at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink color</th>
<th>High Capacity</th>
<th>Standard Capacity</th>
<th>Moderate Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>68</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Cyan</td>
<td>—</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Magenta</td>
<td>—</td>
<td>69</td>
<td>88</td>
</tr>
<tr>
<td>Yellow</td>
<td>—</td>
<td>69</td>
<td>88</td>
</tr>
</tbody>
</table>
Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on.

For best printing results, use up a cartridge within six months of opening the package.

Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold temperatures, allow them to warm up to room temperature for at least 3 hours before using them.

Replacing Ink Cartridges

Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Note:
Leave the expended cartridge installed until you have obtained a replacement, or the ink remaining in the print head nozzles may dry out.

1. Turn on the NX400 Series.
2. If an ink cartridge is low or expended, you see a message on the NX400 Series display screen. Note which cartridges need to be replaced and press OK. If a cartridge is expended, you must replace it to be able to print. If a cartridge is low, you can continue printing until a cartridge needs replacement.
   
   If you’re replacing a cartridge before you see a message on the NX400 Series display screen, press Setup, select Maintenance, and press OK. Then select Change Ink Cartridge and press OK.
3. Open the scanner, and open the cartridge cover.

4. Squeeze the tab on the cartridge and lift it up. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

   **Warning:**
   If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.

5. Before you open the new cartridge package, shake it gently four or five times. Then remove the cartridge from the package.

   **Caution:**
   Do not touch the green chip on the front of the cartridge. This can damage the ink cartridge.

6. Remove the yellow tape from the bottom of the ink cartridge.

   **Caution:**
   Do not remove any other labels or seals, or ink may leak.

34 Maintaining Your All-in-One
7. Insert the new ink cartridge into the holder and push it down until it clicks into place.

8. Once you replace all the cartridges that need replacing, close the cartridge cover and push it down until it clicks into place.

9. Close the scanner.

10. Press OK to begin charging the ink. This takes about 2.5 minutes. When you see a completion message on the display screen, ink charging is finished.

   **Caution:**
   Never turn off the NX400 Series while ink is charging or you’ll waste ink. If you see an ink replacement message on the display screen, press OK and press down all the cartridges securely.

   **Note:**
   If you replaced a cartridge while copying a document or photo, cancel printing and make sure your original is still placed correctly on the document table. Then copy your original again.

   If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
Solving Problems

If you have a problem with your NX400 Series, check the messages on the display screen to diagnose the cause.

You can also check “Problems and Solutions” on page 38 for basic troubleshooting suggestions, or double-click the User's Guide icon on your computer desktop for more detailed help.

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your NX400 Series software. Open your on-screen User's Guide and select Download the Latest Software or visit Epson's support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click Start or , select Programs or All Programs, select EPSON, and click Epson Stylus NX400 Series Driver Update.
Error Indicators

Follow the instructions on the display screen to solve most common problems. If you see one of the error messages below, follow the steps here to proceed.

<table>
<thead>
<tr>
<th>LCD display screen message</th>
<th>Problem and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press the OK button to replace the cartridges.</td>
<td>Replace the expended ink cartridges (see page 33.)</td>
</tr>
<tr>
<td>A printer error has occurred. Turn off the printer and turn it on again. Please see your documentation.</td>
<td>Turn the NX400 Series off, make sure no paper is jammed inside (see page 38), and turn it back on. If the error is not resolved, contact Epson for help (see page 40).</td>
</tr>
<tr>
<td>A scanner error has occurred. See your documentation.</td>
<td>Turn the NX400 Series off and then back on. If the error is not resolved, contact Epson for help (see page 40).</td>
</tr>
<tr>
<td>Waste ink pad in the printer is saturated.</td>
<td>Parts inside the NX400 Series are at the end of their service life. Contact Epson for help (see page 40).</td>
</tr>
<tr>
<td>Cannot recognize the memory card or disk.</td>
<td>The memory card is not inserted correctly or there is a problem with the card. Remove it and check the card. Make sure the card is compatible with your NX400 Series (see page 14).</td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you're having trouble using your NX400 Series.

Printing and Copying Problems

■ Make sure your original is positioned in the front right corner of the glass. If the edges are cropped, move your original away from the edges slightly.

■ Make sure your paper is loaded short edge first and is positioned against the right side with the edge guide against its left side. Don't load paper above the arrow mark inside the edge guide.

■ Make sure the paper size settings are correct for the paper you loaded.

Paper Feeding Problems

■ If paper doesn't feed, remove it from the sheet feeder. Flip through the stack to separate the sheets a little. Then reload the paper against the right side, and slide the left edge guide against the paper (but not too tightly).

■ Do not load too many sheets at once. Load up to 20 sheets of photo paper, 80 of matte, or 120 sheets of plain paper. Load other special papers one sheet at a time.

■ Do not load paper with holes punched in it.

■ If paper is jammed, follow these steps:
  1. Gently pull out jammed paper from the output tray or sheet feeder.
  2. Follow the instructions on the LCD display screen.
  3. If paper is stuck inside, turn off the NX400 Series.
  4. Open the scanner, remove the jammed paper and torn pieces, close the scanner, and turn the NX400 Series back on.
Print Quality Problems

If you have any problems with the copy or print quality, try these solutions:

■ Make sure the document is placed flat against the document table glass and the NX400 Series is not tilted or placed on an uneven surface.

■ Load the paper printable side up (usually the whiter, brighter, or glossy side).

■ Make sure your paper isn’t damp or curled.

■ Use a support sheet with special paper or load your paper one sheet at a time. Remove sheets from the output tray so not too many collect at a time.

■ Make sure the type of paper you loaded matches the paper size and paper type settings on the control panel or in your printer software (see page 27).

■ For the best print quality, use Epson special paper (see page 7) and genuine Epson ink cartridges (see page 32).

■ If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head (see page 31). This unclogs the nozzles so they can deliver ink properly. Run a nozzle check as described on page 30 to see if the print head needs cleaning.

■ Clean the print head as described on page 31.

■ If you notice jagged vertical lines, you may need to align the print head. See your User’s Guide for instructions.

■ The ink cartridges may be low on ink. Check your cartridge status (see page 32) and replace cartridges, if necessary (see page 33).

■ If a dotted line appears in the image, clean the document table glass with a soft, dry, lint-free cloth (paper towels are not recommended and may permanently scratch the surface), or use a small amount of glass cleaner on a soft cloth, if necessary. Do not spray glass cleaner directly on the glass.
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson’s support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Epson Stylus NX400 Series)
■ Product serial number (located on the label in back)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration
■ Description of the problem

Then call:

■ U.S.: (562) 276-4382, 6 AM to 6 PM, Pacific Time, Monday through Friday.
■ Canada: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories
You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Other Software Technical Support
ArcSoft Print Creations
Website: www.arcsoft.com
Notices

Important Safety Instructions

Before using your Epson Stylus NX400 Series all-in-one, read and follow these safety instructions:

- Be sure to follow all warnings and instructions marked on the NX400 Series.
- Use only the type of power source indicated on the NX400 Series label.
- Use only the power cord that comes with the NX400 Series. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
- Place the NX400 Series near a wall outlet where the plug can be easily unplugged.
- Do not let the power cord become damaged or frayed.
- If you use an extension cord with the NX400 Series, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Leave enough room around the NX400 Series for sufficient ventilation. Do not block or cover openings in the NX400 Series case or insert objects through the slots.
- Do not place the NX400 Series near a radiator or heating vent or in direct sunlight.
- Place the NX400 Series on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
- Make sure the back of the NX400 Series is at least 4 inches (10 cm) away from the wall.
- Do not open the scanner section while the NX400 Series is copying, printing, or scanning.
- Do not spill liquid on the NX400 Series.
- Except as specifically explained in your documentation, do not attempt to service the NX400 Series yourself.
Unplug the NX400 Series and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

When storing or transporting the NX400 Series, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

Do not use aerosol products that contain flammable gases inside or around the NX400 Series. Doing so may cause fire.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
- Do not shake ink cartridges after opening their packages; this can cause leakage.
- Do not put your hand inside the NX400 Series or touch any cartridges during printing.
- Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the NX400 Series from printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the NX400 Series. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

**LCD Display Screen Safety**

- Use only a dry, soft cloth to clean the LCD display screen. Do not use liquid or chemical cleansers.
- If the LCD display screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Multifunction printer
Model: C351C
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-4382 (U.S.) or (905) 709-3839 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If Epson authorizes repair instead of exchange, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be repaired and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction
with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY. IN NO EVENT SHALL EPSON OR ITS AFFILIATES BE LIABLE FOR DAMAGES OF ANY KIND IN EXCESS OF THE ORIGINAL RETAIL PURCHASE PRICE OF THE PRODUCT.

In Canada, warranties include both warranties and conditions. Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit: http://www.epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson and Epson Stylus are registered trademarks, Supplies Central is a service mark, and Epson Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

Epson Supplies Central and Epson Connection are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

This information is subject to change without notice.

© 2008 Epson America, Inc. 8/08